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INTRODUCTION

The objective of this Document is to assist qualified persons (QPs) in developing BIM models to meet new
requirements of Building Information Model (BIM) submission. It describes the features available inside the
Architectural BIM e-Submission Template and the step-by-step guide to apply them into the project. The BIM
Submission Template creates a basic structure to assist the QPs in preparing the BIM models for regulatory
approval according to the Architectural BIM e-Submission Guideline. It is by no means an exhaustive

template and QPs are allowed to edit/change accordingly to suit their needs.

For any additional requirements that require customisations to a certain extent, QPs are also advised to
make reference to the training materials distributed or to consult the respective software vendor for any
enquiries on the application. If there are contradictions between this submission guideline and vendor’'s
instructions, BCA BIM team shall be contacted for clarification. Please note that any BIM Submission

Guideline and its Template shall be collected from the BCA BIM team.

This training material is meant for Graphisoft ArchiCAD Users reference only. Diagram below summarises

the important features available in the submission template.

asca
= [ Floor Plans
[ BCA-_FP_ROOF
[ BCA-_FP_ 10th STOREY
[ 8CA-_FP_ 9th STOREY
[ BCA-_FP_8th STOREY . d -
3 BCA-_FP_ 7th STOREY | 5 [ oS o

’ = 4 3 A [ BCA-_FP_ 6th STOREY =
All Model Views in One [ BCA-_FP_. Sth STOREY ~“Rules Added on CP83 Colours
Single File —Lpgidida for A&A and Re-submission —
4 = [ BCA-_FP_ 2nd STOREY = SUTLINS

[ BCA-_FP_ 15t STOREY
5[] Sections
Submissions Grouped o

by Agency ; of the Building Control Act (Cap 29), that -

(a) the preparation of these building plans are in accordance
Regulations; and

Standard Naming (b) the buildings/ building works shown on these plans are in accor
the provisions of the Building Control Regulations and the

Convention g Aoproved Document

. 6
) “Insertion of Endorsement/Declaration
Auto-populated GFA Statement becomes like form filing

Summary Table for
Submission

]

= | % 1,' Communication
N TS c* 2 **°*¢ Regulatory
Professionals Officers

—_— —
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PART I. Getting Started

. In the Start ArchiCAD dialog box, under

section “What would you like to do?” select

“Create a New Project.”

. Tick “Use a Template,” and select 3D-

BIMSubmissionTemplate Sept2013(Archi
CAD17).tpl or;
In the file directory dialog, select Browse

Template... then navigate to the folder
where the BIM submission template file el 1
(tpl) resides. [D ow--«m]
. f‘i ) Open a Project
Choose “Standard Profile 17” as Work bt >
Environment. © Use a Template
30-BIMSubmissionT.... 3(ArchiCAD 17). tpl H
. O b L ArchiCAD 17 Template. tpl ]
Select the template and click Open. ;.;v,;;‘-.,; e
Browse Template...
Set up Work Environment 3
E Use: [Usmdardmn v‘l
4
[71Do ot Display this Dialog Next Time

Note: To ensure originality, please make
sure that you get the BIM Submission
Guideline & template from CORENET

BIM support team

|
Copyright © 2013 Building and Construction Authority. All Rights Reserved. 5
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. Navigator - Layout Book
Once the template is opened, click the & =@

Tree by subset )

Layout Book | e
the right.

. =g #Insert Project Name
at Navigator palette on ‘3@ A.01URA-_LV_ARCHITECT'S DECLARATION
-[(8 A.02 BCA-_LV_ARCHITECT'S DECLARATION
-3 A.03 FSSD-_LV_ARCHITECT'S DECLARATION
A.04 CBPU-_LV_ARCHITECT'S DECLARATION
[ Masters
-[I8 BCA-BP with Acceptable Solutions
.. BCA-BP with Alt Sols_Sole
. [HE BCA-BP with Alt Sols_Join
) . ..[IB BCA-AA
Expand the Masters tab; double click the | | = B BCA-ST with Acceptable Sols
... [ BB BCA-ST with Alt Sols
[l BCA-CD_QP
5 | R B8 URA- Owner Consent, DIP &RLP
Solutions to open. BB URA-Subdivision Appin
----- BB URA-Strata Subdivision Apptn
B8 URA-Conservation_Architect
. BB URA-Conservation_Engineer
----- B FSSD-FSW w Prstv Prvsn FC_BP
... BB FSSD-FSW w Prstv Prvsn FC_FP&AC
When the master layout is opened in the B B S i
... [JB FSSD-FSW w Alt Sols_BP_Option2
-.[BR FSSD-FSW w Alt Sols_FP_Option1
----- B FSSD-FSW w Alt Sols_FP_Option2

to the titleblock on the right of the B O

Sheet/Iayout (as hlghllghted in RED) [ [E8 Other Technical Departments

master layout of BCA-BP with Acceptable

drawing area for editing, you may navigate

customise it according to your company’s

standard, including your company’s logo.

Note: Please try not to change other parts of
the sheet/layout (including the top

corner of the titleblock), as this will
mess up the automated feature |EEr=

available within the template ' Sl
NS j i
=
® -
Repeat Steps 7-8 for customising the _

titleblocks for URA, FSSD and other

technical departments.

Note: This is a one-time setting ONLY so
that you could apply this in all your

future projects.

.Once done, click File menu »

Save (Ctrl+S) to replace the existing 3D-
BIMSubmissionTemplate_Sept2013
(ArchiCAD17) template file.

Copyright © 2013 Building and Construction Authority. All Rights Reserved.
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. Set up Project Settings
Now that you have updated your own BIM @ s s Tinpiie
Submission template, every time you 0-BIMSubmissionT... (ArchicAD17).tol ]
. . ArchiCAD 17 Template. tpl
create a new project (File » New), select ©) Use Latest Proj

the BIM submission template you saved,

. Browse Template...
and click New.

l
PART Il: ArchiCAD Navigator

. Mavigator - View Map [=]
The first thing you see is the navigator palette

B &[EE
on the right, which should contain a structure

E--m #Insert Project Mame
organisation by folder for BIM submission. ] +-[ ) ALL -
. N L =-[L3 BCA
The images on the next page (highlighted in 5[] URA
RED) shows View Map Environment and -4 FssD
4[] PUB
Layout Book: Sheets prepared for Sg CBRU
publishing. [ Indexes
&-CABCA
{#-[E] Floor Plans
Sections
Elevations
#-) 30 Documents
-GBCA-_3D_ Generic Perspective
- @ BCA-_3D_Frontal Axonometry
.[@] Interior Elevations
- [] Details

BCA-_LV_ SUMMARY OF STATISTICAL GROSS FLOOR AREA (SGFA)
BCA-_LV_SUMMARY OF OTHER AREAS NOT INCLUDED IN GFA COMPUTATION

Note: The BIM submission template
creates a basic platform that could
help you in preparing your model for G-QAURA

: Floor Plans
regulatory approval. It is not [] Sections
mandatory and you are free to edit o

i -G URA-_3D_Generic Perspective
acco@ng to your needs, as long as s
the final results presented to the [ Interior Blevations

authorities meet the requirements as

specified in the BIM e-Submission
Guideline.

URA-_LV_ SUMMARY OF GROSS FLOOR AREA (GFA)_ver2
URA-_LV_ SUMMARY OF GROSS FLOOR AREA (E-GFA) Sample

URA-_LV_SUMMARY OF GROSS FLOOR AREA (GFA)_ver1 ]

Copyright © 2013 Building and Construction Authority. All Rights Reserved.
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View Map: Layout Book:
Submission Environment Sheets
Navigator - View Map Navigator - Layout Book
oEE o =(E]
(=)l #Insert Project Name [Tree by subset .]
-0 ALL
©-[3) BCA =g ZInsert Project Name
- [] Floor Plans [8 A.01URA-_LV_ARCHITECT'S DECLARATION
[ BCA-_FP_ROOF [2A.02 BCA-_LV_ARCHITECT'S DECLARATION
[ BCA-_FP_ 10th STOREY 7 [3 A.03FSSD-_LV_ARCHITECT'S DECLARATION
[y BCA-_FP_9th STOREY = [3 A.04 CBPU-_LV_ARCHITECT'S DECLARATION
[ BCA-_FP_ 8th STOREY s (=-[Lg) Masters
[ BCA-_FP_ 7th STOREY a [EB BCA-BP with Acceptable Solutions
[ BCA-_FP_ 6th STOREY P (] I I @B BCA-BP with Alt Sols_Sole
[ BCA-_FP_ 5th STOREY [= | N BB BCA-BP with Alt Sols_Join
[ BCA-_FP_ 4th STOREY = | | — - B BCA-AZA
[ BCA-_FP_ 3rd STOREY w e BB BCA-ST with Acceptable Sols
[BCA-FP_2ndsTOREY | I WM i B BCA-ST with Alt Sols
[gBcA-FP_tstsTorREY | 0 M [ BCA-CD_QP
- 1o secoons 1 Mmoo BB URA- Owner Consent, DIP &RLP
17 BCA-_FX_SECTION S1 innne Il M i BB URA-Subdivision Appin
1 BCA-_FX_SECTION 52 s eCtI ons ...[lB URA-Strata Subdivision Apptn
o 10 Elevatons -8 URA-Conservation_Architect
{0} BCA- FE_ELEVATIONEX | i o 0 BB URA-Conservation_Engineer
5] BCA-_FE_ELEVATION E2 tane 0 BB FSSD-FSW w Prstv Prysn FC_BP
{0} BCA-_FE_ELEVATION E3 EI ev at ions |\ o BB FSSD-FSW w Prstv Prvsn FC_FP&AC
1 BCA- FE_ELEVATIONEY | W M e BB FSSD-FSW w Alt Sols_BP_Option1
@-f@) 30 Documents BB FSSD-FSW w Alt Sols_BP_Option2
S s || I = B FSSD-FSW w Alt Sols_FP_Option1
----- B FSSD-FSW w Alt Sols_FP_Option2
----- 8 FSSD-ASA
----- [ CBPU/PUB-DIP
----- BB Other Technical Departments

PART Ill: Project Elevation/ Reference Level

.Click Design menu » Story Settings. (CTRL+7 or 387)

.By default, the template provides 10 storeys for a project and a consistent floor-to-floor height as
4m for all the 10-storeys. You may need to edit according to your project requirements.

n Story Settings m

No. Name Elevation Height to Next > v

. 10 ROOF 40000 4000 -
. 9 10th STOREY 36000 4000
. 8 Sth STOREY 232000 4000
. 7 8th STOREY 28000 4000
. 8 7th STOREY 24000 4000
. 5 8th STOREY 20000 4000
. 4 5th STOREY 18000 4000
. 3 4th STOREY 12000 4000
. 2 3¢d STOREY 8000 4000
. 1 2nd STOREY 4000 4000

E@mﬁ@ I oo | @ |
[ Insert Above ] [ Insert Below ] [ Delete Story ]
o< )

Copyright © 2013 Building and Construction Authority. All Rights Reserved. 8
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Note: This is a one-time setting ONLY that
you should do it before starting your

project modelling.

_/

. . - 'Dg
.To change project reference levels, click Bl FocgecrPesdere =
Reference Levels - << Previous [ Next >> }

Reference Levels Elevation Relative to

Reference Levels... e . -
I AmsL ]
Sea Level 9 L
[ ml J-100000] _

Note: Reference Levels are display and input aids. Actual Elevation values of model
elements are always calculated from Project Zero. Altitude can be set in the Project

.At the bottom section of Project References poemtensiea e

dialog, select the “Sea Level”, then type

Options menu » Project Preferences »

the project datum value you need in the
Elevation field. And click OK.

3rd STOREY a000
8,000 |
|
|
I
|
2nd STOREY 4000
4,000 i
|
|
I
|

Copyright © 2013 Building and Construction Authority. All Rights Reserved.



Architectural BIM e-Submission Template User Guide (for ArchiCAD Users ONLY) | AC17

Navigator - Project Map
. ==
Double click to open Elevation view E1 [l
..[Bg 10. ROOF
from the Project Map of the Navigator iy pitileing

B 7. 8th STOREY

palette, then use the Arrow tool to select 6. 7th STOREY
[Bx 5. 6th STOREY

. B 4. 5th STOREY

the Elevation marker. [ 3. 4th STOREY

[ 2. 3rd STOREY
[Bm 1. 2nd STOREY
[Pz 0. 1st STOREY
=[] Sections

. £ S1 (Auto-rebuild Model)
£ 52 (Auto-rebuild Model)
Under the Info box, click to open the

Settings dialog of Elevation marker.

§
Worksheets
Details

(=[] 3D Documents

Z31 QTTE DI AN A1 sén_rahild Madai

12 . . . . (' JiJ Dimension Selection Settin [ 2 [
.In the Dimension Selection Settings e sl

. Seteced 1
dialog, select “Sea Level” under the -
- [A' Type and Font
Dimension Origin, and click OK. Dimension Type: Marker Type: &
: b4t o—bi—b ++ @ ¥
o B 4@
SeaLevel > Static Dimension
Project Zero u J ’ @
[ e — =3 ).
. LN o - Western -
Repeat Steps 17-19 for the remaining I — 3w
Elevation Views E2, E3 and E4 (or other B Eled oA
elevation views you may have). v
|
W7LT%'%7¢JQQ W= ﬂ‘gg:%vo ¢ WC.M: S
|
hds.’iﬁ —é—“m L e I > mnsm:;: ¢ ﬂnoooE =
§
msronEvo_é‘ 0000 | unme_\; |oo.ooo: it

Copyright © 2013 Building and Construction Authority. All Rights Reserved. 10
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PART IV.a: Site Configuration

. To import the topographic map (.dwg)

given by your land surveyor, click File

menu » External Content » Attach Xref.

_4

.Click on the origin point of your ArchiCAD

1* floor plan to place the topo map. After

A

the CAD topo map is imported, click Fit in

Window (] at the bottom.

.Select all the elevation and section markers
on the floor plan/elevation and click Drag to
move them to the location of your new
topography map. Similarly, you need to
drag to move the markers and boundary
lines on the elevation and sectional views

to the new location.

Tl Attach Xref 2 [
1
Xref Name: <New XREF> v[ [ Browse... ]
Path:
Reference Type
© Attachment © overlay
Insertion Point Scale Rotation
Specify On-Screen Specify On-Screen Specify On-Screen
X: 0.00 | 1000.00 Angle: 0.00°
¥: 0.00 | 1000.00
() Drawing's own anchor point
() Bounding box node: Tre
RS
Place on story: 0. 1st STOREY -
Translator: 02 For editable import - Settings...
Description: Use this translator to open DXF/DWG content to continue editing them after »
conversion in ArchiCAD.

O,

N 41

384.05
E 36376.12

I3

Copyright © 2013 Building and Construction Authority. All Rights Reserved.
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v P [
. @uyms
Click Document menu » Layers » Layer | = % weeee v | T (shonallny
. . o & lsnd su:Od\L_ANO;TBLK_E
Settings (Model Views). In the Layer =< lnd s 041LE_BLOGFCLT_E0_A LINHAY
o < land su_0d|LE_BLDGPROF_TO_A_
. . o & land su_0d|LE_BRDG—_EQ_A_OVERHEAD
Settings dialog, turn on only the layers to =< ldde oo
. . . B @ land su_0d|LE_ROADKERB_E0_A_
which you want to apply elevation points |=< 2 0LE_TOPODRAN.E0.A_
(the CAD layer with points/contours given 7= e
. o & land su_Od|LE_TOPOSERV_EO_A_ _w
by your land surveyor), and click OK. = oy |
04 i e rorcaom gt i M
[ ([ ]
f‘: o :nasu:od\LE:TﬁvsuNE_;o_;: =
e e Vo L=
o land su_0d|SERVICES L
o land su_0d|TEXT - m

.To create the 3D terrain, double click the F@ &) | <, -, G ®

Mesh tool under the Toolbox, and draw the

boundaries. After the boundaries are set in

the plan, set the height (spot elevations) of

each node along the edge of the mesh. AR A h
; 106,65 v 106.87 10+7.(
J 2 LS
| 0
( %,
( %

.Select the mesh object you just created with
the Arrow Tool under Toolbox and then

click on the Mesh tool to make sure it is " ’ -
ﬂ New Mesh Points M

active. Click the Magic Wand Tool in the
Control Box palette. Ak hen Fona
Create Hole
”Fit to User Ridges -
o ]
e

Copyright © 2013 Building and Construction Authority. All Rights Reserved. 12
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.If the CAD topo map you have are

spots/points, manually insert the points of
terrain with the Magic Wand Tool by
clicking on one of the survey points after
you see the Mercedes cursor. With the
Mesh tool still active, press Spacebar +
click on each survey point and ArchiCAD
will auto-insert a point to the 3D terrain.
Each time, a “New Mesh Points” dialog box

will come up and make sure the “Fit to

A

User Ridges” option is chosen. Continue
Spacebar + clicking on all necessary
survey points until finished. (You only have
to pick the critical points to create the 3D

terrain)

dx: 36357777 l @ Ar: 55084857 ‘ X 42: 100000
Ay: 41381801 a 43.70° » to Sea Level O]

.With the 3D Terrain still selected and the

Mesh Tool active, click and hold the mouse A 6 79

button down on any node/contour lines and

+l

a Pet Palette will appear with options to

move the node or give it a Z elevation.

Choose the Z elevation option.

.When the “Mesh Point Height” dialog box

appears, insert the height accordingly,

based on the value as given by your land
surveyor. Select the reference as “to Sea
Level” (Ensure that you have inserted the
Sea Level in step 15 above). And click OK.

.Repeat Step 28 for the other nodes/ contour

lines of the 3D terrain.

Copyright © 2013 Building and Construction Authority. All Rights Reserved. 13
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PART IV.b: Importing Surveyors Data...

—
[ Eﬂ' n bogumcnt Options Teamwork
) .

Design Teols L4
T %‘5’\ Outline Polygon with Magic Wand
L A8 Story Settings... Ctel+7
1M Edit Story Levels r
Complex Profiles 3|
B Update Zones.,
Align 3D Texture > ¢
E2 Connect 4

E Solid Element Operations...

@ Convert Selection to Morph(s)

Modify Morph L
Modify Curtain Wall 4|
‘ Lrpate Stairlleing © chios
| Place Mesh from Surveyors Data... ‘ |
"I Grid System .. i
\ Roof Extras L
. TAl Place Mesh from Surveyors Data LM
. dh '
Go to Design » Place Mesh from Surveyors | || Surveyors Unit: meter v
Data... Placement: 2
©) Define graphically
(©) Original location

[]Zoom to the new mesh

. ) Project Zero is above Sea Level by: 3
Choose a Surveyor Data file to open. A 0.00 meter
window dialogue will pop to be configured
accordingly then click OK. cncel | [ x|
File name: The CC Place Tanjong Pagar -
Save as type: [Tai Documents ("t} ']

“ Hide Folders Encoding,

ncode
J Unicode big endian
UTF-8

|
Copyright © 2013 Building and Construction Authority. All Rights Reserved. 14
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PART V: Building Orientation to the True North

ildi H : arallel Projection Settings 2 o
.To change the building orientation to the I P Pcjecn Seg |2l

true north on site plan, click View menu »

3D View Mode »3D Projection Settings. In

the Parallel Projection Settings dialog, click

Azimuth

More Sun button at the bottom.

[rs0.007
‘ Sun Azimuth
240.00°
*' Sun Altitude
X 35.00°
Pre-Sets... More Sun... E
. N o
H H H Light Parameters
In the Sun dialog, set the city as Singapore e e
and change the Project North to the true o [ —
X . . . ity (%): = =) low ~
orientation of your building project. Then ::h:m =
: - » B
click OK e : Ep—
Location and Date
Set City... Singapore
Jul v o B 2 Elwo Efm
[7] +1 br Daylight Savings
Sun Azimuth: [FS-F— ﬁ Project North: Fis?x’f*’* c}
Note: Though it's called 'Project' north, it's Ses ‘ ot
true north, in that it's the only north,

and the north used by the sun

settings. Archicad doesn't directly
support a project north environment
variable separate from true north.

Copyright © 2013 Building and Construction Authority. All Rights Reserved. 15
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PART VI: GFA and SGFA Tabulation

For (URA) GFA Tabulation: b P E:

Default Settings
.Double click to open the floor plan from the

navigator palette. {@ T

Hame: <zone name>

MNo.: <room numbers=

lGFh Medical Instituti... [ ']

e Top:  1.2ND STOREY (Ho... (¥
.From the Toolbox select[ Zone tool. Home: 0. 15T STOREY (Curr... (7]

In the Info Box of Zone, assign the layer “L- % .
¥ b: O
_AREAGFAA_A-_"; select the appropriate

Zone Category of your project and insert JAl Zone Defout Settings 12 sl
o

» 7 Name and Positioning
__» [, FloorPlan
h E Zone Stamp

BCA_ZoneStamp ¥ . (m

the Zone Name.

 arial v Western ~  [#] Use Symbol Colors
M1 5.00 mm

>

Zone Polygon (Gross, Net)

.Open Zone Setting;[ (X and in the Zone o o

Show Frame

00°

<zone name>
A 3000m2

£
&
&

Stamp panel - make sure the Zone Name b_Show Zone Name

Show Zone No.

b Show Ventilation

and Measured Area are turned ON then ﬁ e ry——

click OK. Show Perimeter

b Show Ceiling Height
Show Volume

3 for Listing

»

sRe99R®

288

%'S Custom Settings

___» & Tags and Categories

£ (@ L-_AREAGFAA_A-_GFA ») Cancel oK

J

. i N .
In the Info Box, select the Construction T ;t___

= B
Method: Manual £ |and start to draw the | ac |

area boundaries of the floor GFA. Then, 3 Soroy

R

click to place the zone stamp.

|
Copyright © 2013 Building and Construction Authority. All Rights Reserved. 16
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.Double click to open the respective floor s el =
fin} B 9
plan views under the URA folder of the B =TTy =

&[] Floor Plans
i ..[g URA-_FP_ROOF
[P URA-_FP_ 10TH STOREY
-[3 URA-_FP_ 9TH STOREY =
[ URA-_FP_ 8TH STOREY
-[3 URA-_FP_ 7TH STOREY
[ URA-_FP_ 6TH STOREY

View Map in Navigator palette.

w5 URA-_FP_ 5TH STOREY
. URA-_FP_ 4TH STOREY
At the bottom of the navigator palette (if you ol
are using a standard V17 profile), click the N @E&"”"‘“’m =
g )
‘Settings’ button. In the View Settings
Boaax
dialog, click Get Current Windows Settings, v Properties
and C“Ck OK [y URA-_FP_ 2ND STOREY

I Get Cument Windows Setings ] I Selected: 1, Editable: 1

v Identification

ID: Custom Al URA- FP

Name: By Project Map v |1st STOREY

Source: . 1stSTOREY

¥ General
5 Layer Combination: URA -
@ Scale: 1:100 ¥
B Structure Display: Entire Model v
9 Pen Set: 01 3D SUBMISSION 012009 -
Model View Options: SUBMISSION -
@ Renovation Filter: 01 Existing Plan v

Note: Regsrdless of this view's scale, GDL objects will be represented sccording to
the source viewpoint's scale.

¥ 2D/3D Documents

{ Floor Plan Cut Plane Settings... J
& Dimensions: ":';D_Submission_os -
Q Zooming: Fit in window >

[¥] 1gnore zoom when opening this view

» 3D Only

|
Copyright © 2013 Building and Construction Authority. All Rights Reserved. 17
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. Double click to open the “URA-

_LV_SUMMARY OF GROSS FLOOR
AREA (GFA)_ver1” under the Schedules
folder. The GFA is auto-tabulated for you
according to format.

N

.Alternatively you can use the other tables to

suit your need. To configure the settings
click the ‘Scheme Settings...” button.

E-AWRA

[l URA-_LV_SUMMARY OF GROSS FLOOR AREA (E-GFA) Sample

fEm e bar A s e

o (B e u

¢ [Fresterooions ) (W [ e
[ Freeze Schedule Header
Gy g s Lo
|l URA- LV_SUI
T [Block o | Sorey |

u SUMMARY OF GROSS FLOOR AREA (GFA)_ver
URA-_LV_SUMMARY OF GROSS FLOOR AREA (GFA)_ver2
URA-_LV_SUMMARY OF GROSS FLOOR, AREA (E-GFA) Sample
LRA-_LV_DOOR LIST
URA-_LV_ WINDOW LIST EI

GFA areas defined. Open the Zone
Settings » Zone Stamp » Parameters for
Listing » Input Block No.

This way Block No. will auto-generated in
the GFA Table.

Note: You can choose to drag and drop the
tabulated GFA summary into the

layout/sheet, or leave it in the
Schedule folder.

.To insert the Block No of the respective - (e %]

|| Freeze Schedule Header

10 e rEloooDoa[penolonaiEe o[ploookmenalon o]
URA- LV_SUMMARY OF GROSS FLOOR AREA (GFA)
Block No. Storey GFAm2) Usage Type
1 3rd STOREY 2398.5 Commercial
2,388.56 m*

m Zone Default Settings m

Favorites... Default

» 7 MName and Positioning

» [, FloorPlan

hd % Zone Stamp

[BcA_Zonestamp [ R )]

* Arial ~ \Western

M1 s5.00 mm

- [¥]use Symbol Colors

L. Ceiling Material

Block No 147] <zone name>
L. Input GFAvalue A 2000 m2
L. Input Non-GFA value
L.. Input Other Non-GFA value
L. User Defined 1
L. User Defined 2 H
[ 2D Representation

Al
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For (BCA) SGFA Tabulation:

D) o@Ea |

: - Q1BCA-_GenericPerspectve
can be viewed from |- @ BCA-_3D_Frontal Axonometry
Navigator » BCA Folder » -G Detais

- LV_SUMMARY OF STATISTICAL GROSS FLOOR AREA A
[l] BCA-_LV_ SUMMARY OF OTHER AREAS NOT INCLUDED IN GFA COMPUTATION

Schedules
\ )/

. To auto-generate SGFA table; For areas
NOT counted as GFA, from the Toolbox

TJil] BCA-_LV_WINDOW LIST
SR IRA

select l ta Zone tool. In the Info Box of I

i

Description

Zone, assign the layer “A-
_AREAGFAD_A-_.NonGFA”. Select the

appropriate Zone Category and insert the

Zone Name. 0

Zone Category

E-GFA Carpark Residual Areas
E-GFA Communal Landscaped Areas

E-GFA Covered Walkways a
E-GFA Thru Block / Upp Level Linkages
E-GFA Sky Terrace ]
content of each table o Sunmoory GFA ﬁwﬁm,«pﬁm ]
before using. panel helps TR dlerenause [Factory :
- ¥ (= :
you filter the Element type: Zone W o Commercial :
and Layer that will reflect in the ,Z‘r’]"’t—"“'!‘-“"‘— GFA  Hospitality "1
biz - GFA  Education & Cultur .
SGFA table. oA A -1k
i "+, || Solid Line 3 GFAA_EXISTING Area a
contains selected parameters (or Pojsdine 2] caateem .
SGFA GFA +Non-GFA L

information) to reflect in the table
i.e. Description, GFA, Non-GFA and

Total SGFA. /
AN

Tl Zone Default Settings [k
-
(G itioning
» [, Floor Plan
. &) e
Open Zone Setting; I ®== and in the Zone " ve e
v anal || Westem v [7]use Symbol Colors
Stamp panel - make sure the Zone Name Miso
Zone Polygon (Gross, Net) o
and Measured Area are turned ON then For S el oo <aope pame>
click OK. = —
b Slvv\u\!ll-ll.on oft
DS
how 'men‘A :
b e g vignt o
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. . f ne ult Settings m
. After creating a Zone object, select the et
Detaut
object and open the Zone Settings > Zone _———rr
Stamp panel > Parameters for Listing o S
Indicate the Block No. and GFA or Non- e ' =
GFA measured value generated for the N:;“Tm Ml M Lafoe ket
selected zone. e N -
C oz 20 e
This way the Block No., GFA and SGFA will ;ﬁjx::::;:m
auto-generated in the SGFA Table. f.'.':.m':':. {
. Il._mun-nm»r ¥
Repeat steps 43-45 for all Non-GFA T
areas (zones). E i sueces: o o 0
[ Freeze Schedule Header

Note: SUMMARY OF OTHER AREAS

NOT INCLUDED IN GFA

COMPUTATION will auto-generate
the

same NonGFA values
generated from the SUMMARY of
SGFA table, provided you use the
same Layer for the Zone objects.

This makes it easy to generate the
table without doing it from start

again. /
. For areas counted as GFA, from the

Toolbox selecti [a Zone tool. In the Info
assign the “A-
_AREAGFAA_A-_.GFA”. Select  the

appropriate Zone Category of your project

Box of Zone, layer

and insert the Zone Name.

. Repeat steps 44-45 for all GFA areas

(zones).

D 1 I 10 I Zﬂl 1 0 1 4 1 50 1 e 1 70. I 80 I 20 I 100 I 11ﬂl
“1[BCA-_LV_ SUMMARY OF OTHER AREAS [
E_ NOT INCLUDED IN GFA COMPUTATION

& Description

- SIN (Zone Name) AREA(m2)

FA Header Options j_] ™ Selected: 0  Editable: O
[Freese Schedue Header
E]_n""1"“'""|""°°"1' S IRREPREEINEYY
7] BCA-_LV_ SUMMARY OF STATISTICAL GROSS FLOOR AREA (SGFA)

Block No.|  Storey Description | s (mg) | Non-GFA GFA + NonGFA

(Zone Name) m2)

(m2)

Copyright © 2013 Building and Construction Authority. All Rights Reserved.
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PART VI. Annotation & Symbols

Note: The basic annotation and symbols
provided in the template only meant
to help you in creating elementary
annotations  for  your  project

submission. They are not exhaustive
list and you are free to edit/change ‘ FOR REFERENCE ONLY ‘
according to your needs and the
requirements as specified in the BIM
e-Submission Guideline. /
§ [l Object Default Settings [EA™)
== Load Other Object... 3] 7 [[Favortes... Default
. 7 ame———
s BIM Server Libraries - mQ-ntmy[g]
To place the symbol “for reference only” on the | “=&ess Rpo ] 8 @‘?
) . ) . ‘xj:é:“ﬂmmw‘wx | m:m%‘dm o.nn:' 2 [y
drawing views, double click the Object Tool = I
B s @ Home Story:
under the Toolbox. Select the T Tl R —
“Annotation_AuthorityReference” symbol m =
under the Embedded Library. Select the || BT A

‘Show on Stories &
- SYMBOL

placement at appropriate layer and click OK. B ooyt naipes

B> Enable Object’s Pens
O symbolLines
[O.9 SymbolLine Pen

.Click to place the symbol in the drawings.

Master Bedroom
A 1751'364 m2

.To place the zone stamp with indication of

ventilation type, double click the Zone Tool

under the Toolbox.
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.In the Zone Default Settings, make sure that
the “BCA_ZoneStamp” is available under the
Zone Stamp. Then insert the Zone Name,
Zone Category and Ventilation Type etc.
Select the placement at appropriate layer and
click OK.

Note: BCA ZoneStamp is already
part of the Embedded Library
found in the Library Manager of
“3DBIMSubmissionTemplate_

Sept2013(ArchiCAD17)” that was
given to you by the CORENET
BIM support team.

Click Options menu Element
Attributes  Zone  Categories,

select the “BCA _ZoneStamp’,
\ and click OK. /

Tl Zone Selection Setting: [ER=)
Favorites.. Selected: 1 Editable: 1
> 1 Name and Positioning

Zone Category: [ 1 Commercial [ D)
Zone Name: <zone name: No: <room number>
- | & 1 Zone Polygon:
arrys BRE T
Zowa Lot O Zone Stamp Angle:
Relative ®
‘Subfloor Thiciness: 0 % 0000
Gl [VFed angee
» [, FloorPlan
3 Zone Stamp
| BcA_Zonestamp | ¢ m
o rial v Westen ~ [7]Use Symbol Colors
M1 s00 mm
[ Show Zone No.
s g
e i
Text Style
TextPen
Show Flooning
» ‘S _Custom Settings
> 2 Model
» g, Area Calculation
N
> en T
(& orroemi ] e ] [L_ox ]|

.To place the north arrow on the floor plan
views, double click the Object Tool under
Toolbox. Click Libraries » ArchiCAD Library
17 » Object Library 17 » 1.7 2D Elements 17
» Graphic Symbols 17 » Signs 17, then
select North Symbol 17.

.Under the Symbol Styles section, select the
“Scale with plan (Model Size), and “Follow
Project North”. Then place it at appropriate

layer and click OK.

Load Other Object....

[ Embedded Library

() ArchiCAD Library 15
[ 1. BASIC LIBRARY 15
| [0 1.4Buiding Structures 15 | |

| -3 16 Mechanica 15

@) Linked Libraries

-[) 1.1Fumishing 15
[ 1.3 Windows 15
[ 1.5 Spedial Constructions 15
[ 1.7 2D Bements 15
[ Electric Symbols 15
[ Graphic Symbols 15

=]

TESIRE] | Pens snd Colos E
15 |

el e @
%

L

5 :
»
s el

P) e o] Lo ] [ lIQ
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PART VII: A&A Works/ Re-submission (URA)/ Amendments

.By default, all elements/objects available inside
the template are set as Existing (in ArchiCAD
term) or Proposed Element (in magenta,
based on CP83 Part 5). To change or assign
new renovation status, open the viewpoint in
the Project Map of Navigator Palette, select
the element/object you want to change status,
right click and select Object Selection Settings
(or Ctrl + T).

.Under Tags and Categories of the Object
Selection Settings, go to Renovation and
select renovation status (Existing, To Be

Demolished or New) accordingly.

.Click OK.

.Use Renovation Palette to change/ assign
renovation status for multiple elements at one
time by selecting elements first then click on
the renovation icon representing the status

you need under “Default elements:”

=-[E) Stories
B 10. ROOF
[ 9. 10th STOREY.
[ 8. 5th STOREY
[ 7. 8th STOREY

[ 6. 7h STOREY
[ 5. 6th STOREY
[ 4. 5th STOREY
[ 3. 4th STOREY
{8 2. A4 STOREY
B 1. 2nd STOREY
N0 15t STOREY]
& (@) Sectons.
1 51 (Auto-rebuild Mode))
1 52 (Autorebuild Model)
&[] Bevations
0 E1 (Autorebuld Mode) ||

, SELECTED ELEMENT

I ot st s N o
Selectes 1 Eatabl: 1
~ @} Geometry and Positioning
-
W = (Ees =
5 to Cumrent 510-\/@

<l o | Ema  § w
to Project Zero(3) - o )
ML AR [x [0

-! 0
Home Story:
Current (0. 15t STOREY) -

>V Floor Pk
> A Model
» = Listing and Labeling

™ @2 Tagsand Categories

o} WALL
Structural Function Non-Load-Bearing Element
Position Interior

Element Classification ArchiCAD Type

AlRelevant Fiters

Manage IFC Properties...

£Z [®A_WALSRUE_ ¥ [ cancel II! oK II
Default elements:

®la &
Renrm

01 Existing Plan -
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.For additional filter options, go to Document
menu » Set Renovation Filter » Renovation
Filter Options under “Filter Settings” (Show,
“Additional Filter

Hide or Override) and

Options for.”

.To change override styles for each filter
settings, click “Renovation Override Styles...”
Choose which renovation filter to override
(Existing  Element, Elements To Be

Demolished, or New Elements); Check box to

change 2D representation and material on 3D.

.Click OK.

Note: The
based on
codes for

Renovation Filter colour is
the three CP83 colour
A&A |/ Re-submission

(URA)/ Amendments submission, as
specified in the Architectural BIM e-
Submission Guideline and is already

in the
“3DBIMSubmissionTemplate_Sept20
13(ArchiCAD17)” that was given to
you by the CORENET BIM support
team.

Click Document menu » Set
renovation Filter to see Renovation
Filter Options. /

. Click to open the respective floor plan views
under the URA folder of the View Map in
palette. At the bottom of the

A

Navigator
navigator palette. Click the Settings button. In
the View Settings dialog, under General,
select Renovation Filter to represent its A&A

Work status, and click OK.

Document menu »

Set renovation Filter » Renovation Filter
Options.

NS

Override Styles for: 5, Elements to be Demoished -
[¥]Line Type E“:’e"‘_____________'l
[] LineMarker fText Color B =
Framee
[]Fil Foreground Color 2 [
[EFil Background Color

(] Material

[ Paint-0s »|

ID: Custom v URA-FP_
Name:  ByProjectMsp v |iSTSTOREY
Source: . 1STSTOREY
~ General
S Layer Combination: URA hd
@ Scale: 1:100 -
B Structure Display: Entire Model -
@ Pen Set: 3D SUBMISSION 012009 -
B Model View Options: SUBMISSION A
| A Rencvation Filter: A-A Works - |

Note: Regardless of this view's scale, GDL objects will be represented according to
the source viewpoint's scale.

» 2D/3D Documents

» 3D Only

(o | [ox ]
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PART VIlll: Endorsement & Data Information

. Double click to open the sheets from

Layout Books of the Navigator palette.
Click on the sheet on the drawing area and
change the type according to the regulatory

authority you are submitting to.

.Under the Properties palette at the bottom
of the Navigator, select the appropriate
endorsement statement that matches your
submission (refer to Appendix B of BIM e-

Submission Guideline).

Note: Each sheet could only contain 1
endorsement statement. If you have
more than 1 endorsement statement
to submit, create more layouts in the

Layout Book of Navigator Palette.
However, remember to rename the
layout/view according to the naming
convention as specified in the
Architectural BIM  e-Submission

Guideline. /

N

. To insert basic project information and
QP’s name in the title block and the
endorsement statements without repetition,
right click on the Layout tab and select
Project Info.

.In the Project Info dialog, insert all the

necessary information of your project, and
click OK.

Navigator - Layout Book
& m(E
[Tree by subset )

#Insert Project Name

RE=]A.02 BCA- LV_ARCHITECT'S DECLARATION
-8 A.03 FSSD-_LV_ARCHITECT'S DECLARATION
-[8 A.04 CBPU-_LV_ARCHITECT'S DECLARATION

-.[IB BCA-BP with Acceptable Solutions
.38 BCA-BP with Alt Sols_Sole

-[HB BCA-BP with Alt Sols_Join

.[JB BCA-AGA

-.[JB BCA-ST with Acceptable Sols
..[HB BCA-ST with Alt Sols

[l BCA-CD_QP

[l URA- Owner Consent, DIP &RLP
[l URA-Subdivision Appin

-.[JB URA-Strata Subdivision Apptn
.l URA-Conservation_Architect
-.[JB URA-Conservation_Engineer

... [l FSSD-FSW w Prstv Prvsn FC_BP
.. [ FSSD-FSW w Prstv Prvsn FC_FP&AC
. [HB FSSD-FSW w Alt Sols_BP_Option1
.[HB FSSD-FSW w Alt Sols_BP_Option2
[l FSSD-FSW w Alt Sols_FP_Option1
.[HB FSSD-FSW w Alt Sols_FP_Option2

.[HB FSSD-ASA
.[I8 CBPU/PUB-DIP
.[IB Other Technical Departments
() i @ <]
¥ Properties
@ A02 BCA-_LV_ARCHITECT'S DECLARATION
L! (BCA-BP with Acceptable Solutions >
ga1rEge
Navigator - Layout Book X
B o =@
| Tree by subset »

I EJ'G

Book Settings...
th Acceptable Solutions
Alt Sols_Sole

Hn Al+ G
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Note: This is a one-time setting ONLY and the

. - : : [ E4 Project Info X (G
same information will appear in all the — o =
layouts/sheets created. L G [prser Gient Name o) —— |

2 Project Name #Insert Project Name | Delete |
3 Project Number #Insert Project Number
4 Company #Insert Company Name
5 Street —
. : = =
7 State/Country —
8 Postal Code -
In some of the endorsement statements, o e R
. . 10 CAD Technician # Insert DraftPerson
AutoText was not created. You can fill in 11 Project Status
12 Date of Issue
the blanks using the Text tool from o
15 Structural Engineer ----
Toolbox. 16 Accredited Checker —
17 Surveyor #Insert Surveyor Name
18 Architect's Regist... --—
19 Architect's Address ----
20 Mechanical Engin... ——
21 Fire Safety Engin... -
- Save
[ ]

\ /

. Besides endorsement statements and
titleblocks, the sheet could also contain
data information like schedules. Drag and
drop your GFA summary schedules etc.
(as shown in Section V) into the sheet.
Alternatively, you can retain your
schedules in the floor plans, or in the
Schedule folder.

PART XI: Export/Publish to PDF

. Refer to Appendix C of Architectural BIM e-

Submission Guideline for step-by-step

guide to export/ publish to PDF for

regulatory submission.

|
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